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S E C T I O N  O N E

Getting Started
Everything you need to launch ForesightXL for the first

time - from finding the add-in in Excel's ribbon to

signing in with your Microsoft account.

Locating ForesightXL in the Excel ribbon

Opening the Forecast Assistant panel

Signing in with Microsoft
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GETTING  STARTED

Open Excel & Find ForesightXL in the Ribbon

After installing the ForesightXL add-in from the Microsoft Store, open any Excel workbook. You will

find the ForesightXL button in the far-right section of the Excel ribbon under the Home tab. Click it to

open the Forecast Assistant panel.

i If you don't see ForesightXL in the ribbon, ensure the add-in has been installed via the Microsoft Store

and is enabled under Insert → Add-ins → My Add-ins.
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GETTING  STARTED

Sign In with Microsoft

When you first open ForesightXL, the Forecast Assistant panel launches with the sign-in screen.

Click Sign in with Microsoft to authenticate using your existing Microsoft 365 account. New users:

your ForesightXL account is created automatically on first sign-in - no separate registration required.

i Links to Terms & Conditions and Privacy Policy are available at the bottom of the login screen. You can

also reach the support team via the Contact Us link.
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GETTING  STARTED

The Forecast Assistant - Main Interface

Once signed in, the main Forecast Assistant panel is displayed. This is your control centre for every

forecast. It contains three key sections: Set Scope (how many periods to analyse and forecast), Add

Context (optional company URL and file uploads), and Create Forecast (the Generate button).
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S E C T I O N  TWO

Building Your Input
ForesightXL works from a structured Excel input sheet.

This section walks you through generating the

template, entering your data, setting the forecast

scope, and adding business context to improve

forecast accuracy.

Generate the input template with one click

Rename rows and columns to match your data

Set past and forecast period counts

Add your company URL and supporting files

Write free-text business context
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BUILD ING  YOUR  INPUT

Generate the Input Template

If no input sheet exists yet, the panel will show "No input template detected" with a Create → button.

Click Create and ForesightXL will instantly generate a structured FSXL_Input sheet in your workbook

- pre-formatted with rows for your forecast item, supporting drivers, and a context section.

i An FSXL_Output tab is also created at this stage, ready to receive your results once the forecast is

generated.
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BUILD ING  YOUR  INPUT

Fill In Your Data

The FSXL_Input sheet contains the following rows - all of which can be renamed to match your

business:

Forecast item - The primary metric you want to forecast (e.g. Monthly Recurring Revenue).

Supporting drivers 1–3 (optional) - Related metrics that help the AI model understand trends (e.g.

Total Customers, Churn Rate).

Period columns - Rename each column header to the relevant time period (e.g. Jan 2025, Feb 2025).

Enter your actual historical values in each cell.
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BUILD ING  YOUR  INPUT

Set Your Forecast Scope

In the Set Scope section of the panel, configure how many periods ForesightXL should analyse and

project:

Past periods - The number of historical periods from your input data for the model to learn from (e.g.

3 months).

Forecast periods - The number of future periods to generate forecasts for (e.g. 5 months ahead).

i More past periods gives the model more data to detect trends. More forecast periods extends your

outlook further - but forecasts naturally become less precise over longer horizons.
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BUILD ING  YOUR  INPUT

Add Context - Company URL

In the Add Context section, you can optionally enter your Company URL. ForesightXL will use your

website to gather additional background about your business - industry, product, market positioning

- which helps produce more relevant and accurate forecasts without requiring you to type it all

manually.

i This field is optional but recommended. A publicly accessible website gives the model useful context

about your business model and growth drivers.
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BUILD ING  YOUR  INPUT

Upload Supporting Documents

Use the file upload area to attach any relevant documents that provide additional context for your

forecast. Supported formats include text files, PDFs, and Excel spreadsheets up to a maximum of

50MB total. Useful uploads include annual reports, financial statements, board packs, or market

research.

i Uploaded files are processed securely and are not stored in ForesightXL's databases. Forecast data is

transmitted for processing only and discarded after your results are generated.
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BUILD ING  YOUR  INPUT

Complete the Context Section in the Sheet

Before generating, review your FSXL_Input table. The table does not need to be completely filled in -

you only need a forecast item and at least one period of historical data to get started:

Forecast item - Rename and enter values for the primary metric you want to forecast (e.g. Monthly

Recurring Revenue, Total Sales).

Supporting drivers (optional) - Rename and fill in related metrics that help the model understand

what drives your forecast item. You can leave these rows empty or insert additional rows if you need

more drivers.

Period columns - Rename each column to the relevant time period (e.g. Jan 2025) and enter your

actual historical values. You can also insert additional columns for more periods.

Below the table is a CONTEXT row. Enter any free-text business context in the cells below it. The

more context you provide, the more accurate your forecast will be. Consider including:

Company overview · Product & pricing · Growth drivers · Seasonality · Competitive landscape ·

Upcoming events or constraints
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S E C T I O N  T H R E E

Generating Your Forecast
With your inputs complete, ForesightXL does the heavy

lifting - running its forecasting model against your data

and context to produce a detailed, explained output.

Choose between full or summary output

Click Generate and monitor progress

Review your completed forecast

Copy the Executive Summary
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GENERATING  YOUR  FORECAST

Choose Output Type & Click Generate

Before generating, decide on your output preference using the Summary only output toggle:

Toggle OFF (default) - Full output generates a detailed forecast across a dedicated Output sheet and

a Log sheet, including Forecast Components breakdown, explanations, and version tracking.

Toggle ON - Summary only output writes the forecast directly to the main Output page only. No

separate log or output version sheets are created.

When ready, click the Generate button.
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GENERATING  YOUR  FORECAST

Forecast in Progress

Once you click Generate, ForesightXL begins processing. The panel displays a live progress bar

along with a preview of the Executive Summary as it is being written. You can continue working in

Excel while the forecast runs - there is no need to wait on the panel.

i Generation typically completes in under a minute depending on the amount of context and the number of

forecast periods requested.
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GENERATING  YOUR  FORECAST

Your Forecast is Ready

When complete, ForesightXL writes the full results to the FSXL_Output sheet. The output includes

five key components:

Executive Summary - A written narrative explaining the forecast rationale, key drivers, and risks.

Actuals vs Forecast Chart - A line graph comparing historical data to projected values.

Forecast Result Table - Period-by-period forecast values with plain-English explanations for each

period's movement.

Forecast Components Table - A detailed breakdown of every component contributing to each

forecast figure.

Three Suggestions - The AI model provides three tailored suggestions to improve your business

context, helping you maximise the quality of your next forecast output.
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GENERATING  YOUR  FORECAST

Copy the Executive Summary

Once the forecast is complete, the full Executive Summary is displayed directly in the side panel

alongside your output sheet. Click the Copy button to copy the narrative text to your clipboard -

ready to paste into a board report, email, or presentation. The panel also shows the output sheet

names and the timestamp of the last update.

ForesightXL — User Guide Step 13 of 23



04
S E C T I O N  F O U R

Understanding Your Output
A guide to every section of the ForesightXL Output

sheet and how version history is automatically

maintained across multiple forecast runs.

Executive Summary - the narrative

Forecast Result - period values & explanations

Forecast Components - the full breakdown

Three Suggestions - improve your next forecast

Automatic versioning with Log and Output tabs
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UNDERSTANDING  YOUR  OUTPUT

Output Sheet - Full Breakdown

Executive Summary - A written narrative explaining what is driving the forecast, key risks, and the overall

outlook.

Actuals vs Forecast Chart - Visual comparison of historical and projected values on a single line chart.

Three Suggestions - AI-generated recommendations for improving your context inputs on the next run.

Forecast Result - The final projected value for each period with a plain-English explanation of what drove

that number.

Forecast Components - A full audit trail: Mathematical Baseline → Recurring Effects → Business Drivers →

Operating Constraints → Strategic Adjustments.
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UNDERSTANDING  YOUR  OUTPUT

Automatic Version History

Every time you run a forecast, ForesightXL automatically creates two versioned sheets:

FSXL_Log_001, _002, ... - A log record of each generation run, capturing the inputs and settings

used.

FSXL_Output_001, _002, ... - A snapshot of that run's full output, so previous forecasts are never

overwritten.

This means you can always compare forecasts across different runs and see how your projections

evolve as you refine your inputs and context.

Note: If the Summary only output toggle is on, these versioned sheets will not be created - the

forecast is written directly to the main Output page only.

i The FSXL_Output tab always shows the most recent forecast. Versioned tabs (_001, _002, etc.) preserve

every previous run for your records.
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S E C T I O N  F I V E

Account & Billing
Manage your subscription, upgrade to Pro, assign

seats to team members, and access documentation,

support, and legal resources - all from within the add-

in.

Free trial - 5 forecasts included

Accessing your account menu

Viewing and managing your subscription

Upgrading to Pro - billing period, seats & checkout

Assigning seats to your team

Documentation, support & legal links

Terms of Service & Privacy Policy
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ACCOUNT  &  BILL ING

Free Trial - 5 Forecasts Included

All new users receive 5 free forecast generations upon signing in with Microsoft - no credit card

required. The remaining free uses are displayed at the top of the panel. Once your free uses are

exhausted, you will be prompted to upgrade to a Pro subscription to continue generating forecasts.

i Click View plans → at any time to explore subscription options before your free uses run out.
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ACCOUNT  &  BILL ING

Accessing Your Account Menu

Click the ··· (three-dot menu) in the top-right corner of the ForesightXL panel header to access your

account options. The menu displays your name and email address, along with the following links:

Billing & licenses - Manage your subscription, seats, and payment details.

Documentation - Opens the ForesightXL website with full product documentation.

Change log - View the latest product updates and release notes.

Support - Get help from the ForesightXL support team.

Log out - Sign out of your account.
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ACCOUNT  &  BILL ING

Billing & Licenses

The Billing & licenses screen shows your current subscription status at a glance, including your

access level, free uses remaining, renewal date, cancellation status, and seat allocation. To upgrade,

use the Upgrade to Pro section below the status card.
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ACCOUNT  &  BILL ING

Upgrading to Pro

ForesightXL Pro is priced at $19 USD per seat per month, with a 1-month discount if you pay yearly.

To upgrade:

1. Select your preferred billing period - Monthly or Yearly (1 month free).

2. Set the number of seats required using the seat counter.

3. Review the total price, then click Continue to Checkout.

4. Confirm the seat purchase in the confirmation dialog.

5. Complete payment via the Stripe secure checkout (card or Pay with Link).
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ACCOUNT  &  BILL ING

Secure Checkout & Active Subscription

After confirming your seat purchase, you are taken to a Stripe-powered checkout page - fully

embedded within the add-in panel. Enter your card details and complete the payment. Once

successful, your Billing & licenses screen will update to show your active subscription, token usage,

renewal date, and assigned seats.

i Payments are processed securely by Stripe. ForesightXL does not store your payment card details.
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Assigning Seats to Team Members

ForesightXL supports multi-seat subscriptions. From the Billing & licenses screen:

Add seats - Increase the seat count and click Update Seat Count.

Assign a seat - Enter a team member's email and click Assign Seat. They can access Pro

immediately.

Remove a seat - Click Remove next to any assigned user to free that seat.

Manage Billing - Opens the Stripe billing portal for payment methods and invoices.
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ACCOUNT  &  BILL ING

Documentation, Support & Legal

All resources are accessible directly from the ··· account menu within the add-in:

Documentation - Opens foresightxl.com where you can find product articles, FAQs, and a

forecasting framework guide.

Change log - Links to the latest release notes and feature updates on the ForesightXL website.

Support - Opens the support section of the website. You can also reach us at

foresightxl.com/contact-us.

Terms & Conditions and Privacy Policy - Available via links at the bottom of the login screen and on

the ForesightXL website.
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Terms of Service & Privacy Policy

ForesightXL's legal documents are accessible via links at the bottom of the login screen and on the

website at foresightxl.com.

Terms & Conditions - Governs your use of the ForesightXL add-in, APIs, and associated services.

Key sections cover the free trial, paid subscriptions, data processing, and licence & intellectual

property.

Privacy Policy - Details what information is collected during sign-in and usage (Microsoft identity,

usage metadata), how it is stored, and your rights under applicable privacy law including the

Australian Privacy Principles (APPs).
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✦
You're Ready to Forecast

You've completed the ForesightXL walkthrough.

Start generating context-driven forecasts directly

inside Excel - in minutes.

🌐
Website & Documentation

foresightxl.com/user-guide

💬
Support

foresightxl.com/contact-us

📄
Terms & Conditions

foresightxl.com/legal

🔒
Privacy Policy

foresightxl.com/privacy

© 2026 ForesightXL Pty Ltd  ·  ABN 83 695 590 544  ·  Clear forecasts. Explained. In Excel.


